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1Meanings of symbols used

The following table shows the symbols used in this manual, along with descriptions of what they mean.

Indicates something that may cause injury or damage to the projector.

Indicates information that is related to a topic or which may be useful to know.

Indicates a page where a related topic or a more detailed explanation is provided. Click on the page 
number to display that page.

[ (Name) ] Indicates the name of a projector port or a computer menu or item name.
Example: [InputA]  [Start]

Indicates that the explanation continues on the following page. Clicking this symbol will display the 
following page.

Indicates that the explanation is continued from the previous page. Clicking this symbol will display the 
previous page.

CAUTIONCAUTION

TIP
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4Tasks that can be done using EMP Monitor

EMP Monitor lets you carry out operations such as checking the statuses of 
multiple EPSON projectors that are connected to a network at a computer 
monitor, and controlling the projectors from the computer.
Following are brief descriptions of the monitoring and control functions that 
can be carried out using EMP Monitor.
• Registering projectors for monitoring and control

- Projectors on the network can be searched for automatically, and you can 
then select projectors to be registered from the projectors that are detected.

- You can enter the IP addresses for target projectors to register them.
• Registered projectors can also be assigned to groups so that they 

can be monitored and controlled in groups
• Monitoring the statuses of registered projectors

- The power status (ON/OFF) for projectors and problem and warning 
statuses can be checked visually by means of icons.

- You can select groups of projectors or a single projector that you are 
interested in, and then check the cumulative lamp operating time or check 
the details of information on input sources, problems and warnings for 
these projectors.

•  Controlling registered projectors
- Projectors can be selected in groups or as single projectors, and you can 

then carry out operations for the selected projectors such as turning the 
power on and off and switching their input sources. 

- You can select any projector and use the EasyWeb function to change the 
settings of that projector in the configuration menu.

- If there are certain control actions which are carried out regularly at 
particular times or on particular days, you can use "Timer Settings" to 
register timer settings.

• E-mail notification function settings
You can set e-mail addresses for problem notifications to be sent to if a 
problem occurs with a projector that has been registered.

System configuration example

Projector A

Projector B

Group B

I want to turn on the 
power for Group A 
projectors.

EMP Monitor

Group A

TIP

To enable projectors to be monitored and controlled even when they 
are in standby mode*, make the following settings at the projectors. 
The settings that need to be made will vary depending on the projector 
you are using. 
s "Configuration menus" in the projector's User's Guide. 
·  Set "Network Monitoring" to "ON".
·  Set "Standby Mode" to "Network ON".

* When the projector's  (Power) indicator is lit orange



5Operating environment

Compatible computers

Macintosh computers cannot be used.

* Operations carried out at the computer may become slow depending on the 
number of projectors being managed. If this happens, use a computer with 
higher specifications.

* EMP Monitor cannot be used in environments which do not allow pings to 
be transmitted.

Before starting operations

Check the following points before starting up EMP Monitor.
• EMP Monitor must be installed on the computer to be used for 

monitoring and control.
• The computer and the projectors must be connected to the network.
• If using Windows 2000, NT4.0 or XP, the computer must be started up in 

Administrator mode.

When using EMP-821/81/61
• A serial ⇔ TCP/IP conversion adapter and a connection cable are 

required in order to use EMP Monitor.
s"Standby mode" in the projector's User's Guide

• When connecting a projector with a serial ⇔ TCP/IP conversion adapter, 
make the settings of the adapter in advance.
sThe serial ⇔ TCP/IP conversion adapter manual
For details on the adapter settings, see the "Appendices"  sp.30

OS 98SE/Me/NT4.0/2000 Professional/XP Home Edition/XP 
Professional
• Internet Explorer Ver. 5.0 or later must be installed.

CPU Pentium MMX 166 MHz or higher (Pentium II 233 MHz 
or higher recommended)

Memory 
capacity

64 MB or more (128 MB or more recommended)

Free hard disk 
space

20 MB or more

Display SVGA (800×600) or higher resolution, 32 bit or higher 
display colour



6Registering and deleting projectors for monitoring

This operation is carried out when starting EMP Monitor for the first time after 
it has been installed and when you would like to add projectors. Once a 
projector has been registered, the status for the projector will be displayed 
automatically each time EMP Monitor is started from that point onwards.

Starting EMP Monitor

PROCEDURE

Click [Start] - [Programs] (or [All Programs]) - [EPSON 
Projector] - [EMP Monitor V4.02] in that order to start 
EMP Monitor.

The main window will be displayed.

The operations to register projectors using the automatic seraching 
will vary depending on where the projectors are connected to in the 
network.
•When registering a projector that is located in the same segment 
that the computer the EMP Monitor is installed in is associated 
with. s"Registering projectors using automatic search (Searching 
for and registering projectors that are located in the same segment)" 
p.7 

•When registering projectors that are in multiple segments of the 
network s"Setting the range of addresses to do an automatic 
search and registration" p.9

1

2
"Main View"
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Registering projectors using automatic search 
(Searching for and registering projectors that are 
located in the same segment)

PROCEDURE

f Procedures for automatic search

Right-click in "Main View" and select "New" - 
"Projector (automatic search)".
The "Create new projector (automatic registration)" window 
will be displayed.

Click [Search]. 
Automatic searching will be carried out, and the names of the 
projectors that have been detected will be displayed.
• If a projector does not appear in the list, use "Registration by 

specifying an IP address (Manual registration)". sp.11

1

2

TIP

• You can also carry out this operation by selecting "Projector 
(automatic search)" from "New" in the "Edit" menu.

• Projectors that are using a serial ⇔ TCP/IP conversion adapter 
cannot be detected.
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f Procedures for registration

Select the projector(s) to be registered, and then click 
[Edit].
The following window will be displayed.
Make the necessary settings while referring to the table below.

After entering the details, click [Register] to start the 
registration. When the message is displayed, click 
[OK].
To continue registering another projector, repeat the procedure 
from step 3.

To end the registration operation, click the  in the 
top-right corner of the window or click [Cancel]. 
The registered projectors will be displayed in "Main View" 
using the icons that were selected previously in the "Edit" 
window.
Refer to "Monitoring window layout" for details on using the 
main window. sp.16

Display name Enter the name of the projector that is to be displayed 
in "Main View".
Up to a maximum of 32 bytes can be entered. 
A space cannot be used as the first character.

Display icon Select the icon to be displayed in "Main View".

Parent group Select when registering a projector in a group.
If no groups have been created, this cannot be 
selected. s"Registering several projectors to a 
monitoring group all at once" p.12

Projector 
name

This shows the name that has been registered on the 
projector. 

IP address This shows the IP address for the registered projector.

3
Use Serial⇔ 
TCP/IP 
conversion 
adaptor.

This cannot be selected when registering projectors 
using automatic search.

Port Number This cannot be selected when registering projectors 
using automatic search.

Password If a password has been set for the projector, be sure to 
enter the password that has been set. If the correct 
password is not entered at this time, it will not be 
possible to monitor and control the projector even 
though it is registered.

Monitor Select this when you want monitoring to start.

4

TIP

Projectors that have been registered using automatic search are 
searched for again by projector name each time EMP Monitor is 
started.

5
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Setting the range of addresses to do an automatic 
search and registration

PROCEDURE

f Procedures for automatic search

Right-click in "Main View" and select "New" - 
"Projector (automatic search)".
The "Create new projector (automatic registration)" window 
will be displayed.

Select the "Specify an address range and search" 
check box and then enter the starting address and 
ending address in the range.

Click [Search]. 
Automatic searching will be carried out, and the names of the 
projectors that have been detected will be displayed.

TIP

Projectors that are using a serial ⇔ TCP/IP conversion adapter 
cannot be detected.

1

2

3
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f Procedures for registration

Select the projector(s) to be registered, and then click 
[Edit].
The following window will be displayed.
Make the necessary settings while referring to the table below.

After entering the details, click [Register] to start the 
registration. When the message is displayed, click 
[OK].
To continue registering another projector, repeat the procedure 
from step 4.

To end the registration operation, click  in the top-
right corner of the window or click [Cancel]. 
The registered projectors will be displayed in "Main View" 
using the icons that were selected previously in the "Edit" 
window.
Refer to "Monitoring window layout" for details on using the 
main window. sp.16

Display name Enter the name of the projector that is to be displayed 
in "Main View".
Up to a maximum of 32 bytes can be entered. 
A space cannot be used as the first character.

Display icon Select the icon to be displayed in "Main View".

Parent group Select when registering a projector in a group.
If no groups have been created, this cannot be 
selected. s"Registering several projectors to a 
monitoring group all at once" p.12

Projector 
name

This shows the name that has been registered on the 
projector. 

IP address This shows the IP address for the registered projector.

4
Use Serial⇔ 
TCP/IP 
conversion 
adaptor.

This cannot be selected when registering projectors 
using automatic search.

Port Number This cannot be selected when registering projectors 
using automatic search.

Password If a password has been set for the projector, be sure to 
enter the password that has been set. If the correct 
password is not entered at this time, it will not be 
possible to monitor and control the projector even 
though it is registered.

Monitor Select this when you want monitoring to start.

5

TIP

Projectors that have been registered using automatic search are 
searched for again by projector name each time EMP Monitor is 
started.

6
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Registration by specifying an IP address (Manual 
registration)

PROCEDURE

Right-click in "Main View" and select "New" - 
"Projector (manual registration)".
The following window will be displayed.

Enter the IP address of the projector to be registered 
in the "IP address" box and then click [Search]. When 
the message is displayed, click [OK]. 
• If using a serial ⇔ TCP/IP conversion adapter and cable to connect 

the projector, select "Use Serial ⇔ TCP/IP conversion adaptor". 
Enter the port number in "Port Number" and then click [Search]. 

After searching is complete, enter the information for 
the projector to be registered while referring to the 
table below.

1

TIP

You can also carry out this operation by selecting "Projector (manual 
registration)" from "New" in the "Edit" menu.

Display name Enter the name of the projector that is to be displayed 
in "Main View".
Up to a maximum of 32 bytes can be entered. 
A space cannot be used as the first character.

Display icon Select the icon to be displayed in "Main View".

Parent group Select when registering a projector in a group.
If no groups have been created, this cannot be 
selected. s"Registering several projectors to a 
monitoring group all at once" p.12

Projector 
name

This shows the name that has been registered on the 
projector. 

IP address Enter the IP address for the projector to be registered.

Use Serial⇔ 
TCP/IP 
conversion 
adaptor.

Select this if using a serial ⇔ TCP/IP conversion 
adapter to connect the projector.

Port Number If using a serial ⇔ TCP/IP conversion adapter to 
connect the projector, enter the port number.

2

3
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After entering the details, click [Register] to start the 
registration. When the message is displayed, click 
[OK].
The registered projectors will be displayed in "Main View" 
using the icons that were selected previously in the "Manual 
registration" window.

Registering several projectors to a monitoring group 
all at once

Projectors that have been registered can then be registered together into 
different groups so that they can be monitored and controlled together.
Furthermore, if you select one of the registered groups as the "Parent 
group", monitoring and control operations can be carried out for all 
projectors in that "Parent group".
A "Parent group" can be set for other parent groups, so that a hierarchical 
group arrangement such as the following can be created.

First, create the registration groups, and then register projectors into the 
groups that have been created.

Password If a password has been set for the projector, be sure to 
enter the password that has been set. If the correct 
password is not entered at this time, it will not be 
possible to monitor and control the projector even 
though it is registered. If using a serial ⇔ TCP/IP 
conversion adapter to connect the projector, the 
password security function cannot be used.

Monitor Select this when you want monitoring to start.

TIP

"Password" and "Monitor" can be set once searching for the 
projector to be registered is complete.

4

Branch A 

Branch B

Branch C 

Showroom

Convention hall

Conference room 

Reception room

Conference room 

Showroom A

Projector01 

100
101
102

201

No1 

No2 

No3 

Showroom B No4 

No5 Lobby

Projector02 

103

Room 1 
Room 3 

202
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PROCEDURE

Right-click in "Main View" and select "New" - 
"Group".
The following window will be displayed.
Make the necessary settings while referring to the table below.

After entering the details, click [Register] to start the 
registration. When the message is displayed, click 
[OK].
A group icon will be displayed in "Main View".

Right-click the icon that is displayed in "Main View" 
for the projector that is to be registered in the created 
group, and then click [Edit].

In the "Edit projector" window, select the group name 
to use for registering in "Parent group" and then click 
[Change].
The status of the group registration will be displayed as an icon 
in "Main View".

Group name Enter the group name to be displayed in "Main View".
Up to a maximum of 32 bytes can be entered. 
A space cannot be used as the first character.

Display icon Select the icon to be displayed in "Main View".

Parent group This selects the parent group. It cannot be selected if 
no groups have been created.

Monitor Select this to monitor all projectors that have been 
registered in the group. If this is not selected, the 
settings made when the individual projectors were 
registered will be used.
It cannot be set when creating a new group.

1

TIP

You can also carry out this operation by selecting "Group" from 
"New" in the "Edit" menu.

2

3

TIP

You can also carry out this operation by selecting "Edit" from the 
"Edit" menu.

4

TIP

The registration details can also be checked using "Show projector 
list view" in the "View" menu.
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If the projector name or IP address changes after 
registration

f For projectors that have been registered manually

PROCEDURE

Right-click the desired projector icon that is 
displayed in "Main View" and select "Monitoring 
disabled". Then right-click the projector icon again 
and select "Edit".

If only the projector name has been changed, click 
[Search] in the "Edit projector" window that is 
displayed. 
If the IP address has been changed, enter the new IP 
address in the "IP address" box and then click 
[Search]. When the message is displayed, click [OK].

When the display returns to the "Edit projector" 
window, click [Change].

f For projectors that have been registered using automatic 
search

PROCEDURE

In "Main View", delete the projector that has been 
changed. sp.15

Carry out automatic search once more to re-register 
the projector. sp.7

1

TIP

You can also carry out these operations by using the "Edit" menu.

2

3

1

2
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Cancelling (deleting) projector registrations

The registrations for projectors can be deleted if they are no longer 
required for monitoring or control using EMP Monitor.

PROCEDURE

Right-click the icon that is displayed in "Main View" for the 
projector or group registration that is to be deleted, and 
then click [Delete].
When the message is displayed, click [OK].
More than one projector can be selected for deleting in "Main View" at the 
same time.
The methods of selecting more than one projector at the same time are as 
follow.
• If you select a group icon, all projectors that have been registered in that 

group will be deleted at the same time.
• Hold down the [Ctrl] key on the keyboard while clicking on the desired 

icons.
• Use drag and drop to select a range of desired icons.

TIP

You can also carry out this operation by selecting "Delete" from the 
"Edit" menu.
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Monitoring using "Main View"

f Meanings of "Main View" icons

The registered projectors and groups are displayed as icons in "Main 
View", and the patterns on the icons indicate the statuses of the projectors.

The icon patterns and their meanings are explained below.

"Main View" 

If the group 
icons are round 
in shape, it 
indicates that 
there is another 
level below 
them. s p.17

Group

No warnings or problems
All projectors in the group are normal.
Warning or problem
A projector in the group has a warning or problem 
status.
Monitoring disabled
The projector is not being monitored. If you right-
click the icon and select "Monitoring enabled", the 
projector will be added to the projectors that are 
being monitored.

Data being updated
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*1 Check the following items.
• Check that the projector's power is turned on. 
• Check that the LAN cable is connected.
• Check that "Network Monitoring" is set to "ON" and "Standby 

Mode" is set to "Network ON" on the projector.
*2 Check that the projector has been correctly connected to the network.

f Using the icons in "Main View"

The following icon operations can be carried out in "Main View".
• Expanding and collapsing icons

Each time you double-click a group icon, the icons for the projector that 
have been registered in that group are displayed or hidden.

• Moving icons
To change the position of an icon within "Main View", simply drag and 
drop the icon to be moved.

• Searching for desired icons
If several groups and projectors have been registered so that it is difficult 
to find the desired icon, use the following operation to retrieve "Show 
Projector List".
Select "View" menu - "Show projector list view"

The "Show projector list" lets you check the registration details for 
groups in a hierarchical diagram. When you click on an icon, the selected 
icon is displayed in the centre of "Main View".

Projector

No warnings or problems

Warning or problem

Password error
No password was entered when the projector was 
registered, or an incorrect password was entered.
sp.8, 10, 12
Monitoring disabled
The projector is not being monitored. If you right-
click the icon and select "Monitoring enabled", the 
projector will be added to the projectors that are 
being monitored.

Data being updated 

Network error (TCP connection error)*1

Network error (ESC/VP.net communication 
error)*2

TIP

The projector information that is generated when a problem is 
detected is stored until EMP Monitor is closed. The EMP Monitor 
displays will not be updated automatically even if the projector status 
returns to normal. Click [Refresh] in the main window to update the 
status.
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Monitoring using the system tray

The projector statuses are always displayed as icons in the system tray, 
even when "Main View" is not always displayed, and the statuses can be 
checked by the icon patterns.
When the configuration menus are set using the following operations, an 
icon appears in the system tray and the status can be monitored by means 
of the icon's pattern.

PROCEDURE

Select "Environment setup" from the "Tool" menu.
The "Environment setup" window will be displayed.

Select "Resident in the task tray".

Click [OK].

 : No problem

 : Problem

1

2

3

TIP

• Right-click the icon in the system tray to open a pop-up menu to 
select the "Open the main screen" or "Exit".

• If "Register at start up" in the "Environment set up" is selected, 
EMP Monitor starts automatically when the computer's power is 
turned on.
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Displaying projectors with problem or warning 
statuses in a list

You can display a list of only the projectors which have a problem or 
warning status.

PROCEDURE

Select "Warning and Error Projector list" from the "View" 
menu.
The following "Warning and Error Projector list" window will be 
displayed.

The icon patterns and their meanings are explained below.

If you move the 
mouse pointer over 
the icon, details of 
the error and the 
remedy will be 
displayed.

If you double-click in 
a row, the properties 
for that projector will 
be displayed. 
s p.20

Type: Shows the group or projector status. sp.16

Display name: Shows the display name.

Power: Shows the power on status for the projector.

Power on and normal 
status

Power on and abnormal 
status

Power off and normal 
status

Power off and 
abnormal status

Lamp Hours: Shows the lamp operating time for the projector.

Source: Shows the input source that has been selected for the projector.

Computer, Computer1 
or InputA Video

Computer2 or InputB DVI or HDMI (Digital)

BNC D-Video

S-Video Easy MP

Error information: Shows the warning or problem status using the 
following icons.

Lamp life warning High-temperature 
warning

Air-filter replacement Internal (system) error

Lamp cover open error 
(Lamp error) Fan error

Lamp out Sensor error

Lamp failure at power 
on

Electric dual-layered 
capacitor is disconnected

Internal-temperature 
extremes
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Checking properties in detail

You can check the properties of groups and projectors in detail.

f Displaying group properties

You can use either of the following methods to display the properties.
• Displaying the properties for all groups in "Main View"

Right-click in "Main View" and then select "Property".
• Displaying properties for specified groups

Right-click the icon for the desired group and then select "Property".

f Displaying projector properties

Right-click the icon for the desired projector and then select "Property".

If you double-click 
in a row, the 
properties for that 
group or projector 
will be displayed.



21Monitoring window layout

Displaying and deleting logs

In your web browser, you can check a transmission log of content such as 
what has been controlled by the EMP Monitor, projector errors. You can 
delete logs once you have checked them.

f Displaying logs

PROCEDURE

Select "Log" - "show" from the "View" menu.
The web browser will open and the communication logs up until that 
time will be displayed.

f Deleting logs

PROCEDURE

Select "Log" - "Delete" from the "View" menu.
When the confirmation message is displayed, click [OK].
All logs will be deleted and details of EMP Monitor control 
operations and details of projector errors from that point onward will 
be recorded in a new log.

TIP

The transmission log can store up to 10 MB of data.
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Carrying out control using control buttons

Select the icons for groups or individual projectors to be controlled in 
"Main View". If you select a group icon, all projectors that have been 
registered in that group can be controlled at the same time. If you select a 
projector icon, only the selected projector will be controlled.

The meanings of the control buttons are given below.

Power On Turns the projector power on.

Power Off Turns the projector power off.

Switch source 
PC1,InputA

Switches to the input source connected to the 
[Computer] port, [Computer1] port or [InputA] 
port.

Switch source 
PC2,InputB

Switches to the input source connected to the 
[Computer2] port or [InputB] port.

Switch source 
BNC

Switches to the input source connected to the 
[BNC] port.

Control buttons

Switch source 
S-Video

Switches to the input source connected to the 
[S-Video] port.

Switch source 
Video

Switches to the input source connected to the 
[Video] port.

Switch source 
DVI, HDMI

Switches to the input source connected to the [DVI] 
port or [HDMI] port.

Switch source 
D-Video

Switches to the input source connected to the [D4] 
port.

Switch source 
EasyMP

Switches to EasyMP or EasyMP.net.

TIP

• Some connected projectors may not be equipped with all of the 
above ports or functions. If you click a button for a port or function 
that is not available, nothing will happen.

• You can select objects to be controlled and use the control buttons to 
carry out control operations even when the following are being 
displayed. sFor details on each display p.19, 20
· Group properties
· Projector properties
· Warning and Error Projector list (Control operations can only be 
carried out for projectors with a warning status.)
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Carrying out control using a web browser (EasyWeb 
retrieval)

You can use the computer's web browser to change the configuration menu 
settings for projectors.

PROCEDURE

Right-click the icon in "Main View" for the projector to 
be controlled, and then select "View webpages".

The web browser will open and EasyWeb will be 
displayed.

Refer to the documentation provided with the projector for details on using 
EasyWeb.

Carrying out control using timer settings

This is useful for carrying out certain control operations such as turning a 
projector's power on and off at specified times every day or every week.
Timer settings can be carried out either for a single projector only, or all at 
once for all projectors in a group.

PROCEDURE

Select "Timer" - "Timer Settings" from the "Tool" 
menu.
The following window will be displayed and you can then 
check the timer setting status.

1

2

TIP

You can select projectors and right-click on them to select "View 
webpages" even when the following are being displayed.
· Group properties sp.20
· Warning and Error Projector list (Control operations can only be 
carried out for projectors with a warning status.) sp.19

1

The colours in the rows of the list have the following meanings:
: Current day's timer setting
: When some of the projectors in the group have timer setting 
enabled and others have it disabled for the current day's timer 
setting

: When the current day's timer setting is a disabled setting
: Timer setting for a day other than the current day
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The details that can be checked and operations that can be carried out at this 
time are given below.

f Procedures for new timer settings

When you click "Add", the following window is 
displayed and the new timer settings are applied.

In the "Operation", you can carry out the operations of turning 
the power on and off and switching the input sources, similarly 
for the control buttons on the main window. If you set the input 
source switching, the projector's power will turn on at the timer 
start time even if it is not on at the time. Because of this, it is not 
necessary to make two separate timer settings for turning the 
power on and switching the input source.

After completing the timer settings, click [OK].
The timer settings that have been made will be registered and 
they can be checked in the displayed timer list.

Projectors
Selects a group or projector to check the status of.
When a group is selected, the timer setting statuses for 
all projectors in that group are displayed.

Date

Shows the current day in a red box.
Days for which timer settings have been made are shown 
in bold.
Click  or  to switch to the calendar for the 
previous or next month.

Timers Shows a list of the timer settings.

[Enabled]
[Disabled]

Switches the timer settings that have been selected from 
the timer list between enabled and disabled.

[Add] Registers new timer settings.

[Edit]

Lets you change the timer settings that have been 
selected from the timer list.
If a group has been selected for status checking, the 
settings cannot be changed.

[Delete] Lets you delete timer settings that have been selected 
from the timer list.

2

3

TIP

You can enable and disable all of the timer settings that have been 
registered. Select "Timer" - "Enable" or "Disable" from the "Tool" 
menu.
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The mail notification function can be used to send notification messages to 
preset e-mail addresses when a problem or warning occurs with a projector 
that is connected to the network. By using this function, the operator can be 
notified of problems with projectors even when the operator is in a different 
location from the projectors.

PROCEDURE

Select "Mail notification function" from the "Tool" 
menu.

The "Set mail notification function" window will be 
displayed.
Set the following parameters.

TIP

• Up to three addressees (destinations) can be registered and 
messages can be sent to all of them at once. 

• If a critical problem develops with a projector which causes it to 
suddenly stop working, it may not be possible for the projector to 
send a message notifying an operator of the problem.

• If "Standby Mode" is set to "Network ON" or "Network 
Monitoring" is set to "ON" in the projector configuration menus, 
you can monitor the projector even when it is in standby mode 
(when its power is turned off). sProjector’s User's Guide

1

Mail notification 
function

Set to "ON" to use the mail notification function.

SMTP server 
IP address

Enter the IP address of the SMTP server. 
Up to a maximum of 255 bytes can be entered.

When you change a port number of the SMTP 
server, specify this port number. The default value 
is "25".
You can enter a valid number from 1 to 65535.

Sender mail 
address

Enter the sender's e-mail address. Up to a 
maximum of 255 bytes can be entered. 

Recipient 
mail address 1

Specify the destination addresses for the 
notification e-mail. Up to three destinations can be 
set. Up to a maximum of 255 bytes can be entered.

Recipient 
mail address 2

Recipient 
mail address 3

2
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Click [Notification event] and check the items for mail 
notification in the window that appears.

Click [OK].
When the "Set mail notification function" window appears 
again, repeat Steps 3 and 4 to set the events to be notified.

When the setup is complete, click [OK].

3

4

5
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If a problem occurs with a projector, an e-mail message containing the 
following will be sent to all e-mail addresses that have been specified in 
"Recipient mail address".
If there is more than one problem, details for each problem will appear on 
separate lines.

The details contained in the e-mail message can consist of the following.

Messages to inform that the projector has recovered from the error or 
warning statuses are not sent at all.

Item Details shown
E-mail subject [Display name that is displayed in "Main 

View"] Projector warning/error notification

Body The following warning/error has occurred on 
<Display name that is displayed in "Main 
View" (IP address)>
<Warning/error message (Please see the table 
below)>
Immediately check the projector.

Message Remedy
Internal (system) error "Reading the indicators"

s"Reading the Indicators" in the projector's 
User's GuideFan error

Sensor error

Lamp cover open error 
(Lamp error)

Lamp failure at power on

Lamp out

Internal-temperature 
extremes

High-temperature 
warning

Lamp life warning

No signal No image signals are being received by the 
projector. Check the connection status and 
check that the power for the connected 
equipment is turned on.

Electric dual-layered 
capacitor is disconnected

The capacitor is not connected properly. Stop 
using the projector, disconnect the power 
cable from the electrical outlet, and contact 
your dealer or the nearest address provided in 
the "International Warranty Conditions" 
section of the Safety Instructions/World-Wide 
Warranty Terms booklet supplied with the 
projector.

Air-filter replacement Clean or replace the air filter or clean the air 
intake vent.
s"Maintenance" in the projector's User's 
Guide

Network error (TCP 
connection error)

Check that the projector's power is turned on 
and the LAN cable is connected, and also 
check that "Network Monitoring" is set to 
"ON" and "Standby Mode" is set to "Network 
ON".

Network error (ESC/
VP.net communication 
error)

Check that the projector has been correctly 
connected to the network.

Network error 
(password-authentication
error)

Check the projector's password.

Message Remedy
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You can use the application lock to prevent third parties from operating the 
projectors using EMP Monitor and changing settings without authority. 
Opening and closing EMP Monitor and status monitoring can still be carried 
out even when the application lock is applied.
In addition, when a password has been set, the password must be entered in 
order to cancel the application lock. This ensures that the application lock can 
not be easily cancelled, and thus improves system security.

Switching application lock between enabled and 
disabled

f Enabling the lock

PROCEDURE

Select "Application lock" from the "Tool" menu.
The application lock will be enabled and no operations will be 
possible other than opening and closing EMP Monitor and disabling 
the application lock.

f Disabling the lock

PROCEDURE

Select "Application unlock" from the "Tool" menu.

The password entry window will be displayed, so 
enter the set password and then click [OK].
If no password has been set (default setting), click [OK] 
without entering a password. It is recommended that you enter a 
password in order to strengthen security.
The application lock will be cancelled and operations can be 
carried out as normal.

Setting a password for cancelling application lock

Carry out the following operations while application lock is cancelled.

PROCEDURE

Select "Environment setup" from the "Tool" menu.
The "Environment setup" window will be displayed.

Select "Change the application lock password".

Enter the password in both the "New password" and 
"New password (confirm)" boxes and then click [OK].
The password can be up to 16 bytes in length. Single-byte 
alphanumeric characters can be used.

1

2

1

2

3
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Projectors cannot be monitored or controlled An e-mail message is not sent when a problem 
occurs with a projector

Cause Remedy
Is the projector connected to 
the network correctly?

Connect the network cable correctly. 
s"Network Cable Connections" in the 
projector's User's Guide

Has the projector been set 
up correctly for connection 
to the network?

Check the settings for the "Network" 
configuration menu command.
sProjector's User's Guide

Has EMP Monitor been 
installed on the computer 
correctly?

Uninstall EMP Monitor and then re-install 
it. 

Are all the projectors that 
you want to control or 
monitor registered in "Main 
View"?

Register the projector in "Main View". 
sp.6

Is the projector's "Network 
Monitoring" or "Standby 
Mode" configuration menu 
set to "ON" or "Network 
ON"?

In order to use EMP Monitor to monitor 
and control the projector when it is in 
standby mode, the projector's "Network 
Monitoring" or "Standby Mode" 
configuration menu must be set to "ON" or 
"Network ON".
sProjector's User's Guide

Cause Remedy
Is the projector connected to 
the network correctly?

Connect the network cable correctly. 
s"Network Cable Connections" in the 
projector's User's Guide

Has the projector been set 
up correctly for connection 
to the network?

Check the settings for the "Network" 
configuration menu command.
sProjector's User's Guide

Have the SMTP server IP 
address, port number and 
recipient e-mail address all 
been set correctly?

Check the setting details.

Is the projector's "Network 
Monitoring" or "Standby 
Mode" configuration menu 
set to "ON" or "Network 
ON"?

To use the mail notification function while 
the projector is in standby mode, set 
"Network Monitoring" or "Standby Mode" 
to "ON" or "Network ON" in the 
projector's configuration menus.
sProjector's User's Guide

Has a critical problem 
developed causing the 
projector to momentarily 
stop working?

When the projector has momentarily 
stopped working, it cannot send e-mail 
messages. If the projector cannot be reset 
even after it has been checked, contact your 
dealer or the nearest address provided in 
the "International Warranty Conditions" 
section of the Safety Instructions/World-
Wide Warranty Terms booklet supplied 
with the projector.

Is power being supplied to 
the projector?

Check if the power supply to the location 
where the projector is set up has been 
interrupted, or if the circuit breaker for the 
electrical outlet that the projector is 
connected to has been tripped.
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Serial ⇔ TCP/IP conversion adapter settings

If using the EMP-821/81/61, the following serial ⇔ TCP/IP conversion adapter settings must be made.

Menu Main Item Sub Item
Setting

UDS100 UDS200
Port Properties Serial Port Settings Serial Protocol RS232

Speed 9600

Character Size 8

Parity None

Stopbit 1

Flow Control None

Connect Mode Settings UDP Datagram Mode Disable

UDP Datagram Type (Blank)

Response Nothing (quiet)

Additional Settings Port Password Disable

Telnet Mode Disable

Inactivity Timeout Enable

Port Password (Blank)

Security Security Settings Encryption – Disable 
(Not selectable)

Twofish Key – (Blank)
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